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Preface

This documents provides information pertaining to this release of Oracle JRockit 
Mission Control Client. It includes information on platform support, new features, and 
resolved and known issues.

About this Document
This document is comprised of these chapters:

■ Chapter 1, "New Features and Enhancements", which describes new features and 
enhancements in Oracle JRockit Mission Control 4.x Client.

■ Chapter 2, "Resolved Issues", which describes existing issues that have been fixed 
in Oracle JRockit Mission Control 4.x Client.

■ Chapter 3, "Known Issues", which describes issues known to exist in Oracle 
JRockit Mission Control 4.x Client.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.
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monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1New Features and Enhancements

This chapter describes the new features and enhancements in Oracle JRockit Mission 
Control.

This chapter includes the following topics:

■ Section 1.1, "New Features and Enhancements in Release 4.1"

■ Section 1.2, "New Features and Enhancements in Release 4.0"

1.1 New Features and Enhancements in Release 4.1
Oracle JRockit Mission Control 4.1 release includes the following new features and 
enhancements:

■ Support for Oracle JDK 7

■ New Platforms

■ Upgrade to Eclipse 3.7

■ Support for Associating JRockit Flight Recorder File with the JRockit Mission 
Control Client on Windows

■ New DTrace Plug-in

■ New Features and Enhancements in Mangement Console

■ New Features and Enhancements in JRockit Flight Recorder

■ New Features and Enhancements in JRockit Memory Leak Detector

1.1.1 Support for Oracle JDK 7
You can use Oracle JRockit Mission Control 4.1 with Java SE 7. Oracle JRockit Mission 
Control can also start the local management on Hotspot JDK 1.6 and later. However, 
you will still need to connect to a JRockit JVM to be able to use most of the JRockit 
Mission Control tools. 

Note that some of the features of the Management Console are not available when 
JRockit Mission Control 4.1.x client is used to monitor Java SE 7 JVM.

1.1.2 New Platforms
Oracle JRockit Mission Control client 4.1 works on new platforms. Oracle JRockit 
Mission Control is available as technology previews on Mac OS X, Solaris x86, and 
Solaris SPARC. The technology previews are available as Eclipse plug-ins. For more 
information about how to install the plug-ins, vist the Eclipse Update Site at:  
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http://download.oracle.com/technology/products/missioncontrol/updatesites/
base/4.1.0/eclipse/.

1.1.3 Upgrade to Eclipse 3.7
Oracle JRockit Mission Control 4.1 client is built to run on Eclipse 3.7 and later. 

1.1.4 Support for Associating JRockit Flight Recorder File with the JRockit Mission 
Control Client on Windows

Starting with Oracle JRockit Mission Control 4.1, the installers for Oracle JRockit JDK 
with Oracle JRockit Mission Control on Windows associate JRockit Flight Recorder 
(.jfr) files with the highest version of JRockit Mission Control client installed in your 
machine. The files with the .jfr extension are opened in the JRockit Mission Control 
client by default when you run the following command:

product_install_dir\bin\jrmc.exe -open recording.jfr

1.1.5 New DTrace Plug-in
DTrace Plug-in for JRockit Mission Control is now available at the Update site.

To install the plug-in for the stand-alone version of JRockit Mission Control, select 
Install plug-ins... from the Help menu of JRockit Mission Control client. To install the 
DTrace plug-in for Eclipse, first install the Eclipse plug-in version of JRockit Mission 
Control and then install the DTrace plug-in from the JRockit Mission Control 
Experimental Update Site.

JRockit Mission Control provides a domain specific language (DSL) for defining 
DTrace events. This DSL extends the DScript syntax to make the data self describing. 
The default .de script provides probes for recording both HotSpot as well as the data 
from the operating system. This makes it easier to bring the the data into the JRockit 
Mission Control event model. If you run JRockit Mission Control on Eclipse, the DSL 
provides an editor with features such as syntax highlighting.

The DTrace Recording wizard allows you to configure the parameters declared in the 
.de file as well as to enable and disable probe sets.

The DTrace Analysis GUI provided with the DTrace plug-in uses the JRockit Flight 
Recorder components and GUI editor. 

1.1.6 New Features and Enhancements in Mangement Console
The Management Console of the JRockit Mission Control 4.1 client includes the 
following new features and enhancements:

■ Improved file resource operations in the Eclipse environment.

■ Improved zooming in capability for charts.

■ Default trigger rules are available for deadlocks.

■ Coherence plug-in is available at the Update site.

■ Introduced two new tabs, Server Information and Native Memory.

■ Enhancements in Overview and Thread tabs to support HotSpot JVM.

1.1.7 New Features and Enhancements in JRockit Flight Recorder
JRockit Flight Recorder includes the following new features and enhancements:
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■ The Thread graph renders thread transition information.

■ Improved selection and zooming in the Thread graph.

■ Long thread names in the Thread graph will be truncated and only the important 
information will be displayed.

■ A new operative set action adds all events occurring during the same time and in 
the same thread as a selection of events to the operative set.

■ The performance of the parser as well as the memory footprint has been 
optimized.

■ The built-in GUI editor of JRockit Mission Control has been improved.

1.1.8 New Features and Enhancements in JRockit Memory Leak Detector
JRockit Memory Leak Detector includes the following new features and 
enhancements:

■ Introduced context menu options for selecting a random instance and class loader 
of the type.

■ An extension point is now available for better instance visualization.

■ The Trend Analysis table now includes columns that show the instance count and 
memory growth. You can reset these columns.

■ Introduces an option to increase the instance limit directly from the instance view.

■ Introduces a toggle switch in the toolbar to switch between the graph and tree 
representations.

1.2 New Features and Enhancements in Release 4.0
The JRockit Mission Control 4.0 release includes the following new features and 
enhancements:

■ Upgrade to Eclipse 3.5

■ Oracle JRockit Flight Recorder

■ Updated Memory Leak Detector

■ Restart Prompt Added When High Contrast Mode is Enabled or Disabled

■ Welcome Page Added to RCP Version of JRockit Mission Control

■ Auto-Scale Feature Improved

■ Sorting Tables from the Context Menu

■ Line Graphs with Only One Value are Easier to See

■ Optional Labels Available for Graphic Controls on GUI

1.2.1 Upgrade to Eclipse 3.5
The Oracle JRockit Mission Control update site now requires Eclipse 3.5.

1.2.2 Oracle JRockit Flight Recorder
The JRockit Flight Recorder is a performance monitoring and profiling tool that makes 
diagnostics information always available, even in the wake of catastrophic failure, 
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such as a system crash. At its most basic, JFR is a rotating buffer of diagnostics and 
profiling data that is always available, on demand. You might consider it a sort of 
"time machine" that enables you to go back in time to gather diagnostics data leading 
up to an event. The data stored in the rotating buffer includes JVM and application 
events.

In JRockit Mission Control 4.0 Client, the Flight Recorder allows users who are 
running a Flight Recorder-compliant version of the Oracle JRockit JVM (that is, 
version R28.0 or later) to view the JVM's recordings, current recording settings, and 
runtime parameters on a series of tabs that aggregate performance data into logical, 
task-based groups. The data on these tabs is presented by way of an assortment of 
dials, chart, and tables. At the top of each tab is a sliding window, called the Range 
Navigator, with which you can expand or narrow the range of reporting; for example, 
if you see a group of events clustered around a specific time period, you can adjust the 
Range Navigator to include just those events, with the resulting data for just those 
events appearing on the tab components.

Making flight recordings is simplified by using Flight Recording Wizard, which allows 
you to create recordings by using templates that define the sort of event information 
you want reported. When you use the Wizard, you select the template that you want 
to use, the duration of the recording, and the file name under which you wan the 
recording stored. You can also use the Wizard for such advanced tasks as modifying 
an existing template, saving a modified template for future use, or importing and 
using a template from another server

The Flight Recorder supplants the JRockit Runtime Analyzer available in earlier 
versions of JRockit Mission Control.

1.2.3 Updated Memory Leak Detector
The JRockit Memory Leak Detector has been updates, as described in these sections:

■ Section 1.2.3.1, "New Look and Feel"

■ Section 1.2.3.2, "Shortest Path to Garbage Collection Root"

■ Section 1.2.3.3, "Improved Instance Listing"

■ Section 1.2.3.4, "Class Loader Support Added"

1.2.3.1 New Look and Feel
Versions of the Memory Leak Detector in JRockit Mission Control 3.1 and earlier were 
basically Swing applications. This was required to enable support for J2SE 1.4 on all 
platforms. JRockit Mission Control 4.0 Client is a component of Oracle JRockit JDK 
R28.0, from which support for J2SE 1.4 has been dropped, and can now use 
SWT/JFace components for its graphical user interface. The ultimate result of this 
change is the Memory Leak Detector GUI has the same look and feel as the other 
JRockit Mission Control plug-ins.

1.2.3.2 Shortest Path to Garbage Collection Root
For any instance, you can now see multiple levels of back references at once by 
automatically expanding the shortest path to a garbage collection root. In previous 
versions of JRockit Mission Control, a user would need to follow references back to the 
root when, for instance, using large frameworks. When the depth was more than a 
trivial amount of references deep and/or the branching factor was large (that is, with 
many instance variables or references), this was a very inefficient and often confusing 
process. Now, you can expand to the garbage collection root simply by selecting 
Expand to Root from a context menu on a highlighted node.
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1.2.3.3 Improved Instance Listing
Earlier versions of the Memory Leak Detector made it difficult to find all instances of a 
specific type. Now, wherever there is a type, the context menu enables you to List All 
Instances. The instances will appear on an Instances table in the left-hand panel of the 
Memory Leak Detector GUI.

1.2.3.4 Class Loader Support Added
You can now investigate memory leaks based upon their class loader. In previous 
versions, no matter how many actual types you had with a certain class name (each 
loaded by a different class loader) they were all lumped together and displayed as a 
single type. Now, you may, per view, switch between this mode and to actually show 
all the loaded classes, including the class loader that loaded each of them.

1.2.4 Restart Prompt Added When High Contrast Mode is Enabled or Disabled
JRockit Mission Control Client now displays a message dialog box and prompts you to 
restart Mission Control when high contrast mode is turned on or off in the operating 
system.

1.2.5 Welcome Page Added to RCP Version of JRockit Mission Control
The RCP/standalone version of JRockit Mission Control 4.0.0 features a welcome page 
that provides a brief introduction to the product.

1.2.6 Auto-Scale Feature Improved
The auto-scale feature in this version of JRockit Mission Control Client has been 
improved:

■ Auto-scale in graphs has been improved and is now based only on values visible 
in the graph.

■ You can now use auto-scale while always showing the zero level in graphs in the 
Management Console.

1.2.7  Sorting Tables from the Context Menu
You can now sort the columns in a table from the context menu (as well as by clicking 
on the column header as before).

1.2.8 Line Graphs with Only One Value are Easier to See
Data series with only a single value are now easier to see in graphs. The single value is 
marked with an X in line graphs and you can optionally extrapolate line graphs and 
filled graphs to mark the "missing" data on both sides of a data series.

1.2.9 Optional Labels Available for Graphic Controls on GUI
The new accessibility option Show labels on buttons enables text labels on buttons and 
icons that otherwise only have a description in a tool tip.
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2Resolved Issues

This chapter describes all issues that existed in earlier releases of Oracle JRockit 
Mission Control Client that have been resolved in 4.x versions. 

This chapter includes the following topics:

■ Section 2.1, "Issues Resolved in Release 4.1"

■ Section 2.2, "Issues Resolved in Release 4.0"

2.1 Issues Resolved in Release 4.1
This section describes some of the issues existed in earlier releases of Oracle JRockit 
Mission Control Client that are resolved in release 4.1. These issues include:

■ The Entire Operative Set is No Longer Visible on Event Tabs

■ Export Graph To Image Works in Release 4.1

■ Issue with Modifier Keys for Memory Leak Graphs Is Resolved

■ Reason for Garbage Collection is Presented in Flight Recorder

■ Error When you Kill a Monitored Java Process

■ JRockit Mission Control Can Read MBeans Deployed by JBoss

2.1.1 The Entire Operative Set is No Longer Visible on Event Tabs
The entire operative set was visible in the range selector on the Events tab group, 
regardless of the event types that were selected in the Event Types tree.

This issue has been resolved.

2.1.2 Export Graph To Image Works in Release 4.1
The export graph-to-image functionality in the Memory Leak Detector was not 
working in Oracle JRockit Mission Control 4.0. This issue has been resolved.

2.1.3 Issue with Modifier Keys for Memory Leak Graphs Is Resolved 
Keyboard modifier keys in Memory Leak graphs were not consistent with the 
Windows usage. This issue has been resolved.

2.1.4 Reason for Garbage Collection is Presented in Flight Recorder
The Flight Recorder GC tab now shows the reason for launching a garbage collection.
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2.1.5 Error When you Kill a Monitored Java Process
If you kill the java process that the Mission Control console monitors, an error 
messaged used to be displayed. The issue has been resolved.

2.1.6 JRockit Mission Control Can Read MBeans Deployed by JBoss
When you connect to a JBoss instance, JRockit Mission Control now reads the JBoss 
MBeans correctly.

2.2 Issues Resolved in Release 4.0
This section describes all issues that existed in earlier releases of Oracle JRockit 
Mission Control Client that have been resolved in release 4.0. These issues include:

■ Dial Properties Popup Accessibility Issue Resolved

■ Zooming-In to Console No Longer Throws Exception

■ Colors are No Longer Hard Coded in the Management Console

■ Graphs with Single Value Strange No Longer Can Appear Blank

■ Some Hardcoded Strings Required Externalization

2.2.1 Dial Properties Popup Accessibility Issue Resolved

When tabbing backwards in the Properties dialog box for the JRockit Mission Control 
Console dashboard dials, you no longer get stuck in the Formatting combo box. Also, 
the Show Watermark combo box gets both visual and audible focus. 

2.2.2 Zooming-In to Console No Longer Throws Exception

In earlier releases of JRockit Mission Control Client, excessive zooming in the 
Management Console was throwing an exception. This has been fixed.

2.2.3 Colors are No Longer Hard Coded in the Management Console

In earlier releases of JRockit Mission Control Management Console, some colors were 
hard-coded, ignoring system colors and high contrast mode. In this release, Colors are 
no longer hard coded.

2.2.4 Graphs with Single Value Strange No Longer Can Appear Blank
 

In earlier releases of JRockit Mission Control, graphs with only a single Y value might 
appear blank when auto range was enabled. This has been fixed.

2.2.5 Some Hardcoded Strings Required Externalization
Some strings that were hard-coded to English are now translated properly in 
internationalized versions of JRockit Mission Control.
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3Known Issues

This chapter lists issues that are known to exist in JRockit Mission Control Client.

The known issues are described in the following sections:

■ Section 3.1, "Issue with Menu Items in the Flight Recorder View On Linux"

■ Section 3.2, "Issues while Using Large Fonts in Flight Recorder View"

■ Section 3.3, "NullPointerException Occurs when the JVM Fails"

■ Section 3.4, "The Internal Help Browser Fails due to Proxy Settings"

■ Section 3.5, "The Option to Set Help Context does Not Work on Linux"

■ Section 3.6, "Issue with Latency Data in Flight Recorder"

■ Section 3.7, "MBean Exposure"

■ Section 3.8, "JRockit Mission Control Crashes When Using Chinese Locale on 
Solaris 10"

■ Section 3.9, "Strings Generated from Server-Side Metadata Not Translated"

■ Section 3.10, "GUI Strings Might be Truncated on Linux"

■ Section 3.11, "Linux Welcome Page Might be Blank Without Mozilla Path"

■ Section 3.12, "JRockit Mission Control Client Not Supported With X-Win32"

■ Section 3.13, "Some RCP Strings Are Not Localized"

■ Section 3.14, "JVM Crashes With Older Versions of libpango when Exiting Mission 
Control"

■ Section 3.15, "Visible Columns Not Always Available on Flight Recorder Context 
Menu"

3.1 Issue with Menu Items in the Flight Recorder View On Linux

On Linux, a problem may occur with the context menu in the Flight Recorder Control 
View. Some menu items such as "Start Flight Recording..." may not function properly. 
No dialog box will be opened when you select the menu item and an exception will 
also be logged.

This problem occur only when you have already opened the Flight Recorder Control 
view and then right click on a connection in the JVM Browser to select menu items in 
the Flight Recorder Control view. The Flight Recorder Control view that was opened 
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earlier seems to break so that the context menu is not usable anymore. Note that this 
problem does not occur on Windows.

Workaround:

Close the Flight Recorder Control View and then open it again. It can be opened by 
one of the following two methods:

■ Select Window > Show View > Flight Recorder Control

■ Right click on a JVM connection in the JVM Browser and select the menu item 
"Show Recordings". The menu items in the context menu will work again. 

3.2 Issues while Using Large Fonts in Flight Recorder View

If the font size is specified as 200%, and the screen resolution is smaller than 1680 x 
1050, the scrollbars in the Memory > Overview tab of Flight Recorder fails to display 
all data.

The texts in the Event Graph of the Flight Recorder can also overlap if the font size is 
200%. The texts in both the time stamps (columns) and the thread names (rows) might 
overlap.

Workaround:
Increase the screen resolution.

3.3 NullPointerException Occurs when the JVM Fails

If you have started a Flight Recording on a JVM and if the JVM fails, you may get an 
error message as follows:

"An internal error occurred during: "My 
Recording".java.lang.NullPointerException"

You can view the stack trace for the NullPointerException in the console log. 

3.4 The Internal Help Browser Fails due to Proxy Settings 

A proxy-related issue may cause the internal help browser to fail.

Workaround:
Use the external help browser by changing the preferences. Select Window > 
Preferences and then select Help. In the Open help contents drop down list, select In 
an external browser.

3.5 The Option to Set Help Context does Not Work on Linux

The option to set help context dialogs are missing on some Linux platforms.
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3.6 Issue with Latency Data in Flight Recorder

When investigating a flight recording of a limited time period you may see events that 
have a duration that is longer than the recording itself.

All events that end within the selected time period are presented for the investigated 
recording. The longer events that end within this limited time period might have 
started before the recording.

Workaround:
To avoid this issue, make sure that no other flight recording is active when you start 
your recording.

3.7 MBean Exposure
The JRockit JDK exposes Mbeans under the oracle.jrockit.management domain, 
accessible through the Management Console.

3.8 JRockit Mission Control Crashes When Using Chinese Locale on 
Solaris 10

 

Running Java GUI applications using Chinese locale (zh_CN.UTF-8) on 64-bit Solaris 
10 Update 2 and later might fail with a core dump. See the Sun bug 6901233 at 
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6901233. 

Workaround:

Apply the relevant Solaris 10 patches listed at the end of the Sun bug report. If the 
installation of Oracle JRockit Mission Control or Oracle JRockit Real Time fails in GUI 
mode, consider using console mode (-mode=console) as a workaround. 

3.9 Strings Generated from Server-Side Metadata Not Translated

Some strings, such as attribute metadata shown in the trigger wizard of the JRockit 
Management Console, are generated on the server. Such information will not be 
localized by JRockit Mission Control.

3.10 GUI Strings Might be Truncated on Linux

On Linux the Pango library is typically used to layout and render text. Versions older 
than 1.14.9-3 might, in some cases, truncate GUI strings.

If the version of libpng (the PNG reference library) is older than 12.so.0.44.0, you 
might see truncated titles on JRockit Mission Control Client.

3.11 Linux Welcome Page Might be Blank Without Mozilla Path 
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For some Linux configurations, you might need to set up the library path and Mozilla 
home in the environment variables for the Help and Welcome pages to show properly. 
Set: 

export MOZILLA_FIVE_HOME=/usr/lib64/firefox-xxx 
export LD_LIBRARY_PATH=$MOZILLA_FIVE_HOME:$LD_LIBRARY_PATH

3.12 JRockit Mission Control Client Not Supported With X-Win32

You should not use X-Win32 to hook up to a JRockit Mission Control client running on 
Linux. A problem with SWT over X-Win32 renders scrollbars inoperable.

3.13 Some RCP Strings Are Not Localized
 

Some strings will not be localized in the GUI. This will mainly affect framework 
strings from the Rich Client Platform, such as the Close, Close All and Exit 
strings. 

Workaround:

Download the localization pack for Eclipse for the desired language   from the Babel 
project on the Eclipse home page:

http://download.eclipse.org/technology/babel/babel_language_
packs/galileo.php 

Unpack the language pack in your missioncontrol folder and restart JRockit Mission 
Control. 

3.14 JVM Crashes With Older Versions of libpango when Exiting Mission 
Control

On Linux systems, if you are using libpango versions earlier than 1.14, you might 
encounter JVM crashes when closing JRockit Mission Control. 

Workaround:

Upgrade to libpango version 1.1.4 or later.

3.15 Visible Columns Not Always Available on Flight Recorder Context 
Menu 

If your first context click (right click) is on the table header, the menu command 
Visible Columns will be unavailable for that particular table as long as the recording 
is open. If your first context click is on a table row, this issue will not occur on that 
particular table until you close the recording.
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Note: This issue is only a problem when your first action on the table 
is to right click the table column while, at the same time, trying to 
change the column’s visibility. If you click in the table or left click at 
the column headers, it will work as designed.
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